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Introduction 
Employee Accounts and Splits enables companies to better manage their payroll’s variety of unique 

payroll accounting practices. Employee Accounts and Splits allows companies to dynamically create 

payroll posting accounts by allowing account numbers to be assigned to the individual employee. 

Account numbers can also be assigned to the employee transaction during the transaction entry process. 

This process greatly reduces the number of entries in the Payroll Posting Accounts Setup window. 

Normally in an organization, an employee works in one organizational unit (Company + Division + 

Department + Position + Location under a Supervisor). However, other scenarios of employment often 

exist within the organization for some employees, such as: 

1. Employees regularly work in multiple areas within the organization. 

2. Employees at times work in other areas within the organization. 

3. Employees have responsibilities across multiple areas within the organization. 

4. Employees can work in varying accounting cost centers throughout the year. 

5. Employees can work in varying accounting cost centers during a single pay period. 

6. Employees can work on Multiple Projects. 

When these other employment scenarios occur, a system is needed that tracks the employees 

organizational unit(s) and related employee information throughout their employment, both for the 

current years status and previous history, instead of just the department/position from where the 

transaction originated. The system needs to be able to distribute accounting detail to the appropriate 

accounting cost centers in these diverse scenarios. Furthermore, users should have the ability to easily 

enter time and select inputs that results in an accurate entry of the organizational unit and distribution of 

the associated accounting, utilizing automation where possible. 

In addition, the Employee Accounts and Splits product allows companies to automatically split payroll 

transactions to specific Departments and Positions as well as specify the GL Posting Account, overriding 

any Payroll Posting Account Setup options and then dynamically create payroll posting accounts. 

Organizations need the ability to create different split schedules for each Employee + Department + 

Position + Pay Code combination. Each Employee + Department + Position + Pay Code combination can 

then be assigned unlimited Department + Position combinations for that Pay Code. A percentage is 

assigned to the Department / Position combination to determine the percentage of the hours split in the 

new transactions. When the original transaction meets the criteria, it is changed into multiple new 

transactions based on the schedules setup for that Employee + Department + Position. 

 

Employee Accounts and Splits enables HR personnel to expand the core HR statuses and better track job 

(Department +Position combination) history information. When changes occur, the standard Microsoft 

Dynamics GP history tables are updated as well as the Employee Accounts and Splits history tables that 

can be accessed by Smart List Builder and SQL Reporting Services for custom reporting and Extender for 

the display of history in a window if needed. 
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Employee Accounts and Splits Transaction 

Posting Essentials 
Summary: 

Priority sequence of GL Account Posting when using a combination of Employee Accounts and Splits 

options: 

1st - ‘Payroll Transaction GL Account’ account number(s).  

2nd - ‘Employee Splits Setup’ account number(s). 

3rd - ‘Employee Positions Maintenance’ account number. 

4th - ‘Posting Account Setup’ account number. 

Detail: 

1. When a GL Account number is assigned to an employee transaction in the ‘Payroll Transaction GL 

Account’ window, the system will use that account number for GL Account Posting.  

2. When there is not an account number assigned to an employee transaction in the ‘Payroll 

Transaction GL Account’ window and a Split code is assigned to an employee and the transaction 

criteria matches the criteria of the Split code, then the transaction splits according to the setup in 

the ‘Splits Assigned to this Employee’ section. The system uses each account number and 

corresponding percentage as the basis for applying the configuration setup on the ‘Payroll 

Account Options’ window for the GL distributions. More than one Split code can be set up to Split 

transactions differently based on the transaction itself. (i.e. A salary or hourly pay code can be 

split differently than another type of pay code, like commission or bonus). 

3. When there is not an account number assigned to an employee transaction in the ‘Payroll 

Transaction GL Account’ window and when the transaction criteria does not match the criteria of 

the Split code or there is no Split code set up, then the system looks for a match between the 

transaction criteria (Employee ID, Department and Position) and the criteria on a record on the 

‘Employee Positions Maintenance’ window (Employee ID, Department, Position and Year, which is 

determined by the user date) and uses the account number assigned to that record as the basis 

for applying the configuration setup on the ‘Payroll Account Options’ window for the GL 

distributions. 

4. When there is not an account number assigned to an employee transaction in the ‘Payroll 

Transaction GL Account’ window and when the transaction criteria does not match the criteria of 

the Split code or there is no Split code set up, and if there is no match between transaction 

criteria and the criteria on a record on the ‘Employee Positions Maintenance’ window or the 

account number on the matched record is not provided on the ‘Employee Positions Maintenance’ 

window, then only the ‘Payroll Posting Accounts Setup’ applies for all the GL distributions. 

5. When there is not an account number assigned to an employee transaction in the ‘Payroll 

Transaction GL Account’ window and when the transaction criteria does not match the criteria of 

the Split code or there is no Split code set up and if the ‘Employee Positions Maintenance’ 
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window is disabled, then only the ‘Payroll Posting Accounts Setup’ applies for all the GL 

distributions. 

6. Only employees with an account number assigned to them in either, ‘Employee Splits Setup’ 

and/or ‘Employee Positions Maintenance’ is affected by the ‘Payroll Account Options’ settings. 

The system would pull the GL Account Number for All other employees from the GP Payroll 

Posting Account window. 
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Installation Overview  
This section will discuss the prerequisites, list the files installed and go through the install process. The 

HRM Solution Series Extensions consists of two modules that provide additional capabilities for an 

existing Microsoft Dynamics GP installation: Employee Accounts and Splits and FTE Manager. 

Prerequisite 
The prerequisite for Employee Accounts and Splits is: 

 Employee Accounts and Splits: U.S. Payroll 

 FTE Manager*: Human Resources 

* U.S. Payroll is required to use the full functionality of FTE Manager. 

Install Notes  

Prior to installing complete the steps: 

1. Confirm all users are logged out of Microsoft Dynamics GP 

2. Complete all payroll runs and validate no payroll runs are in process 

3. Make a backup of the Company and Dynamics databases 

Server/Client 
To install Employee Accounts and Splits downloaded the exe file from our website.  Once the files have 

been downloaded, you can run them on the Server and/or Client Installations.   The product will need to 

be installed on all machines that process payroll.  If you will send with using Microsoft Outlook then 

download the Outlook Setup.exe in addition to the Integrity GP 2013 Setup.exe 

 

Complete the steps required at the Server and/or Client level to create the necessary Microsoft SQL 

Server® Components.  Creating the Microsoft SQL Server Components needs to be performed on a 

single computer, typically the server. 

1. Right click Integrity Data GP2013 Setup.exe file and select “Run as Administrator”.  If you do not 

see this option, hold the shift key down and right click. 

2. Complete the steps in the wizard 

http://www.integrity-data.com/hrp/product-download-form/0310360942-2/
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3. Verify the GP directory is correct if it is not select Change 
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4. Select Custom to choose to install only the specific products you purchased.   

5. Select Activation Components to only install activation manager files.  This option will not install 

products and it is typically ran only to fix an error with activation manager. 

6. Select All Components to install all Integrity Data products.  The products you did not purchase 

will register with a 30-day trial period.   
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If you are upgrading you will be prompted to uninstall the older version, select y. If you have 

multiple products, it will uninstall all products. 

 

7. Select the product(s) to install, if installing multiple products, select all that need to be installed. 
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8. Launch Microsoft Dynamics GP 2013. 

9. If prompted to include new code, choose yes. 

10. Login as the ‘system administrator’ for each company to create the SQL Server components. 

11. The system will auto activate the products you have purchased if you have access to the internet 

on the machine.  If you receive a message Activation Manager failed contact support@integrity-

data.com and include a screenshot of the Activation Manager window to receive manual keys. 

 

  

BEST PRACTICES 

Install is not a 
requirement on the 
Server; however it is 

recommended. 

Install updated version on 
previously installed Client 

machines. 

 

 

mailto:support@integrity-data.com
mailto:support@integrity-data.com
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Files Installed 
The following files are installed: 

GP Folder (C:\Program Files\Microsoft Dynamics\GP2013) 

 HRMSSEXT.cnk  

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 IDA6537.cnk  

 Integrity.Registration.Addin.dll 

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2013\Documentation) 

 Employee Accounts and Splits GP 2013 User Guide.pdf  

Manual Install  
If the user encounters errors during the installation, complete the following steps to manually install 

Employee Accounts and Splits: 

1. Contact support@integrity-data.com to receive the manual install files for the product(s). 

2. Copy and paste the following files into the appropriate locations.  

GP Folder (C:\Program Files\Microsoft Dynamics\GP2013) 

 HRMSSEXT.cnk  

 Application.IntegrityDataActivation.dll  

 Integrity.Registration.Constructor.dll  

 Integrity.Registration.Addin.dll 

 IDA6537.cnk  

Documentation Folder (C:\Program Files\Microsoft Dynamics\GP2013\Documentation) 

 Employee Accounts and Splits GP 2013 User Guide.pdf  

3. Edit the Dynamics.exe.config 

a. Navigate to the GP folder (C:\Program Files\Microsoft Dynamics\GP2013) 

a. Backup the Dynamics.exe.config by making a copy and saving the copy **Important** 

b. Open Dynamics.exe.config in Notepad 

c. Find the <addin> and under <Dynamics> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=11.0.5.

20123,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

d. Under <DynamicsGPweb> copy and paste the following: 

<addin name="IDKeyManagerAddIn" 

type="Integrity.Registration.Addin.GPAddIn,Integrity.Registration.Addin,Version=11.0.5.

20123,Culture=neutral,PublicKeyToken=b7ed37edf026e3bc"/> 

mailto:support@integrity-data.com
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4. Launch Microsoft Dynamics GP. 

5. Login as the ‘system administrator’ for each company to create the SQL Server components. 
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Registration 
The system will automatically activate the product during the login process.  If the activation was 

successful, the user will not receive any messages. However, if the activation process was unsuccessful 

the user will receive a message.  If the activation process fails the user will need to open the Activation 

Manager window to activate the product. 

Activation Manager Window 
Microsoft Dynamics GP > Tools > Setup > System > Activation Manager 

 

The Site Name defaults from the session information on the About Microsoft Dynamics GP window. 

From the Product drop-down list the user may select the product they wish to activate and review 

product information.  Once the product is selected the following fields will display: 

 Installed Version – Current version number installed. 

 Enhancement Plan Date – Date of the enhancement plan expiration. 

 Activation Status – Current status of the product. 

o Permanent – Product has been purchased. 

o Trial – Product has been issued a trial period. 

o Deactivated – Product has been deactivated. 

 Current Employees – This count defaults from the session information on the About Microsoft 

Dynamics GP window.  The count does not include inactive employees or employees in a Test or 

Historical company.  If the current employee count is incorrect validate Test or Historical 

companies are named correctly.   

 Employees Allowed – The number of employees allowed before the product will be inactivated.  

If the Current Employees exceeds the Employees Allowed the system will deactivate the product.   
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The scrolling window contains a list of all companies. By default the product is active for all companies.  If 

the user would like to inactivate a company unmark the company checkbox.   

The Auto Activation option may be selected if the user receives a message at login stating the product is 

not activated.  When the user selects the Auto Activation option the system will attempt to automatically 

activate the product.  Once the Auto Activation process is complete the system will display the Activation 

Messages.  For a detailed list of activation messages see the Activation Manager Messages section. 

The Manual Activation option is used to manually enter a token.  The user would only manually enter a 

token if they were sent a token by Integrity Data. 

Select the OK button to close the window.   

Test and/or Historical Companies 
Registration will not count the active employees in Test or Historical company databases if the Company 

Name is named correctly, specifically at the end of the Company Name the user must append the 

following: “<TEST>” or “<HISTORICAL>”. See examples below: 

 Dextordinary, Inc. <TEST> 

 Dextordinary, Inc. <HISTORICAL> 

To access and modify the Company Name open the Company Setup window via Microsoft Dynamics GP > 

Tools > Setup > Company > Company when logged into the Test or Historical Company that needs 

modified. 

Version Information 
To obtain the latest Employee Accounts and Splits version information, visit our website. 

Within Microsoft Dynamics GP verify the version for Employee Accounts and Splits by selecting the Help 

Button, select About Microsoft Dynamics GP and then select the Options button. Click OK until the 

Employee Accounts and Splits window appears. 

http://www.integrity-data.com/hrp/product-releases/
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Security Settings  
The Security Task Setup window may be used to grant or restrict access to the Employee Accounts and 

Splits windows. To open the window, select the Microsoft Dynamics GP menu, select Tools, select Setup, 

select System, select Security Tasks and enter the system password. 

1. Select the appropriate Task items. To identify the appropriate task item complete the steps 
below: 

• Open the User Security Setup window (Microsoft Dynamics GP > Tools > Setup > User 
Security), select the appropriate user and make a note of the Security Role ID assigned to 
the user. 

• Open the Security Role Setup window (Microsoft Dynamics GP > Tools > Setup > Security 
Roles), select the Role ID that has been assigned to the user and make note of the 
Security Task ID assigned to the Role. Use this Task ID to grant security to the Employee 
Accounts and Splits. 
NOTE: The most common Task ID used is TRX_PAYRL_004 – Print Payroll Checks 

2. Select Employee Accounts and Splits for the Product. 

3. Select Windows for the Type and select 3rd Party for the Series. 

4. Use the Access List to grant or restrict access to individual items. 

 To grant or restrict access to an item for this Task ID, click the checkbox to mark or 
unmark the item. 

 Click the Mark All button to grant access to all items in the list or click the Unmark All 
button to restrict access to all items in the list. 

5. Click File > Print to print the Security Task Setup Report for the selected Task ID. 

6. Choose OK to save your changes. 

 

Employee Accounts and Splits > Windows > 3rd Party > Access List 

 Copy Employee Positions 

 Employee Positions Maintenance 

 Employee Split Lookup 

 Employee Split Setup 

 Payroll Account Options 

 FTE Manager Password Entry 

 FTE Manager Budget Import 

 FTE Manager Budget Maintenance 

 FTE Manager Hire 

 Payroll Transaction GL Account 

 FTE Manager Maintenance 

 FTE Manager Password Setup 

 FTE Manager Pay Code Setup 
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 FTE Manager Requisition 

 FTE Manager Statistics by Status 

 Position Status Lookup 

 Progress Control 

 Registration Key Entry 

 Status Setup 

 Year 

 Employee Accounts and Splits > Reports > 3rd Party > Access List 

 APR Account Validation Report 

 APR Employee Pay Detail Report 

 APR Employee Split Detail Report 

 APR Pay Code Setup Report 

 APR PC Budget Maintenance 

 APR PC Manager Master 

 APR PC Statistics by Status 

 APR Status Setup 
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Payroll Account Options Window 
Microsoft Dynamics GP > Tools > Setup > Payroll > Payroll Account Options 

HR & Payroll > Setup > Payroll > Payroll Account Options 

 

The Payroll Account Options window allows a user to select the options that control how an account is 

posted in payroll and select the Payroll Account Types that are affected. The Payroll Account Options 

window allows the user to link the Account Segment to a Data Source that enables the system to 

dynamically assign GL Accounts to payroll transactions. The Employee Positions Maintenance window can 

be disabled when an organization only needs to use the Employee Splits Setup or the Payroll Transaction 

GL Account functionality. 

 

 Account Segment – defaults from the Account Format Setup window. (Example Below) 
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 Data Source – A Data Source option must be selected for each Account Segment. The options are 

as follows: 

o Employee – this segment is retrieved from the: 

 Employee Positions Maintenance window > Account Number field for GL Posting  

 Employee Split Setup window > Splits assigned to this Employee Account 

Number field for GL Posting  

 Payroll Transaction GL Account >GL Account field for GL Posting 

o Posting Account Setup – this segment is retrieved from the: 

 Payroll Posting Account Setup window for GL Posting. 

 Use account from Payroll Posting Account Setup when a valid account cannot be found for DR 

balance posting types – 

o For DR balance posting types: 

 When this option is selected, it allows the system to use the account number 

from the Payroll Posting Account Setup when a valid GL account cannot be 

generated for DR balance posting types. 

 When this option is not selected and an invalid account is generated in the 

exchange segment process, then Microsoft Dynamics® GP generates the error 

message that an account cannot be found during the Calculate Checks process. 

o For CR balance posting types: 

 Whether this option is 

selected or not and an invalid 

account is generated in the 

exchange segment process, 

the system uses the account 

number from the Payroll 

Posting Account Setup when 

a valid GL account cannot be 

generated for CR balance 

posting types.  

 Disable Employee Positions Maintenance window – When this option is selected the Employee 

Positions Maintenance does not display when the Cards > Payroll > Employee > Additional 

Positions button is selected. The Microsoft Dynamics GP Employee Positions Maintenance 

window does display when the Cards > Payroll > Employee > Additional Positions button is 

selected. This option is useful when an organization only needs to use the Employee Splits Setup 

functionality. 

Tip: Both the Employee Positions 
Maintenance window and the 

Employee Split Setup window have the 
Validate Accounts button that should 

be selected as part of the setup 
process when a new record is added. 
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 Build Expense Distributions Based on Wage Distributions - When this option is selected the 

following Payroll Account Types below will have their GL expense distributed according to the 

wage distributions. 

o Employer's Tax Expense (DR) 

o Benefits Expense (DR) 

o Taxable Benefits Expense (DR) 

Example 1: Fabrikam Biweekly Employee BARR0001 with gross wages of $2000 and $200 Health 

Insurance Benefit has two transactions: 

Trx 1 = ACCT – ATC – HOUR – 40 hrs account #: 00-5100-00 

Trx 2 = ACCT – ADA – HOUR – 40 hrs account #: 00-5110-00 

Total hours = 80 Wage Distribution would be: 

Trx 1 50% (40/80) therefore Gross Wages to account 00-5100-00 = 50% of $2000 = $1000 and 

Benefit Expense would be to the account number determined by the setup in the Payroll Posting 

Accounts window for Benefit Expense and subject to the Payroll Account Options Data Source 

and = 50% of $200 = $100. 

Trx 2 50% (40/80) therefore Gross Wages to account 00-5110-00 = 50% of $2000 = $1000 and 

Benefit Expense would be to the account number determined by the setup in the Payroll Posting 

Accounts window for Benefit Expense and subject to the Payroll Account Options Data Source 

and = 50% of $200 = $100. 
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 Enable GL Account Entry for Payroll Transaction - When this option is selected the user will be 

able to enter an account number in the Payroll Transaction GL Account window > GL Account 

field for an employee transaction in the Payroll transaction Entry window. 

o The displaying of the Payroll Transaction GL Account window is based on the selection in 

the drop down list: 

o Auto – when an employee transaction in the Payroll Transaction Entry window is saved, 

the Payroll Transaction GL Account window will open. 

o Prompt - when an employee transaction in the Payroll Transaction Entry window is saved, 

the user will receive the following message: 

 

o None - when an employee transaction in the Payroll Transaction Entry window is saved, 

the user would need to open the Payroll Transaction GL Account window by selecting: 

 

 Suppress Account Validation Report Prompt - When this option is selected the Account Validation 

Report message will not appear during the Build Checks process. 

 Apply To – the user needs to select the appropriate Payroll Account Types to apply to payroll 

transactions. 

o Gross Wages (DR) 

o Federal Withholding (CR) 

o State Withholding (CR) 

o Local Tax Withholding (CR) 

o Deduction Withholding (CR) 

o Employer's Tax Expense (DR) 

o Benefits Expense (DR) 

o Benefits Payable (CR) 
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o Taxable Benefits Expense (DR) 

o Taxable Benefits Payable (CR) 

o FUTA Expense (DR) 

o SUTA Expense (DR) 

o Workman’s Compensation Expense (DR) 
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Payroll Transaction GL Account Window  
Transactions > Payroll > Transaction Entry > Additional > Transaction GL Account 

The Payroll Transaction GL Account window allows account numbers to be assigned to the employee 

transaction during the transaction entry process. 

 

 GL Account - Enter the account number that will be used for this transaction. If the user assigns a 

GL account to a payroll transaction, that account is used for the wages only and will not impact 

any other Posting Types. If the user wants to have this account impact the other wage related 

expenses, they can mark “Build expense distributions based on wage distributions.” 
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Splits Code Setup window 
Microsoft Dynamics GP > Tools > Setup > Payroll > Splits Code Setup 

The Splits Code Setup window allows the user to set up the criteria for splitting a payroll transaction into 

multiple transactions based on specific Department, Position and Pay Code and to specify the accounts to 

which the transactions are posted to GL. Multiple Split codes can be set up, each with its own criteria, to 

distribute the GL Postings based on working in various combinations of Departments, Positions and Pay 

Codes. If the criteria matches a payroll transaction, the Splits supersedes the Employee Positions 

Maintenance posting methodology. The Splits posting follows the rules set up in the Payroll Accounts 

Options window. 

 

 

 Split Code [REQUIRED] – Enter a new Split Code 

or use the look up button to modify an existing 

Split Code. 

o Split Code Lookup button – opens the 

Split Code Lookup window that allows 

the user to select a Split Code.  

Multiple Split codes can be set up, each with its 

own criteria, to distribute the GL Postings based 

on working in various combinations of 

Departments, Positions and Pay Codes. 
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 Split Description – enter split description. 

 Criteria [REQUIRED] – select Department, Position and Pay Code combinations that should be 

split.  When a payroll transaction is processed for an employee assigned to this split code with the 

Department, Position and Pay Code criteria the system will split the record based on the 

information entered in the Splits Assigned to this code.   

o Department – the Criteria scrolling window retrieves the records from the Department 

Setup window. 

o Position – the Criteria scrolling window retrieves the records from the Position Setup 

window. 

o Pay Code – the Criteria scrolling window retrieves the records from the Pay Code Setup 

window. 

 Add button – individually selects the Departments, Positions or Pay Codes. 

 Add All button – selects all Departments, Positions or Pay Codes. 

 Remove button – individually removes the selected Department, Position or Pay Code. 

 Remove All button – removes all Departments, Positions or Pay Codes. 

Splits Assigned to this Code Scrolling Window 

 Department [REQUIRED] – select a Department by typing the code or utilizing the Lookup 
button. 

o Department Lookup button – opens the Departments Lookup window which allows the 
user to select a Department by Code. 

 Position [REQUIRED] – select a Position by typing the code or utilizing the Lookup button. 

o Position Lookup button – opens the Positions Lookup window that allows the user to 
select a Position by Code. 

 Account Number – can be entered by typing it, selecting the Lookup button or utilizing the 
Expansion button. Payroll Transactions processed for the selected Year, Department and Position 
are posted to the GL Account entered. If no Account is entered, the system looks to the Payroll 
Posting Accounts Setup to determine the GL Account applied. Employee Split records override 
any records created within the Employee Positions 
Maintenance window. 

o Account Lookup button – opens the Accounts 
Lookup window that allows the user to select 
the Account number. 

o Account Expansion button – opens the Account 
Entry window that allows the user to select a 
GL account by Alias.  

 Percent – enter allocation percentage for each job. The total percentage must equal 100%. 

Department and Position combination 

must be selected prior to selecting the 

Expansion button or utilizing the 

Account Lookup. 
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 Save button – select this button to save the record. 

 Clear button – select this button to clear the current window. 

 Delete button – select this button to delete the current record. 

 Redisplay button – select this button to redisplay the current record. 

 Validate Accounts button – select this button to validate the account numbers. The system 

ensures the GL account created based on settings in the Payroll Account Options window and the 

Employee Positions Maintenance record generates a valid account. (See previous section on 

Validate Accounts.) 

 Window Level Note – Notes that can be attached to the window. 

 Printer button – select this button to print the Split Detail Report. 
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Status Code Setup Window 
Microsoft Dynamics GP > Tools > Setup > Payroll > Status Code Setup 

HR & Payroll > Setup > Payroll > Status Code Setup 

The Status Code Setup window provides the user the ability to create Position Status Codes, map the 

code to an existing HR Status Code and determine the codes impact to FTE calculations. 

 

 Status Code – select a Status Code by typing the Status Code or utilizing the Lookup button. 

o Status Code Lookup button – opens the Position Status Lookup window which allows the 

user to select the Status Code. 

 Description – enter or modify the description of the Status Code. 

The following are examples of how the Status could be set up: 

ACCESSED SEP - Accessed 

CAR LEAV WO PAY LOA - Career Leave WO Pay 

CAR LEAVE W PAY LOA - Career Leave W Pay 

COMPLETION TRNG ACT - Completion of Training 

DEATH SEP - Death 

DEPT TRANSFER ACT - Department Transfer 

DOWNSIZE SEP - Downsized 

FMLA FML - FMLA 

FTE CHG PERM ACT - FTE Change - Permanent 

FTE CHG REDUCED ACT - FTE Change - Reduced 

FTE CHG TEMP ACT - FTE Change - Temporary 

LAID OFF SEP - Laid Off 

LEAVE OF ABSENC LOA - Leave of Absence 
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LEAVE W PAY LOA - Leave With Pay 

LEAVE WO PAY LOA - Leave Without Pay 

MATERNITY MAT - Maternity 

MIL LEAV WO PAY LOA - Military Leave WO pay 

MIL LEAVE W PAY LOA - Military Leave With Pay 

OTHER OTH - Other 

POS TRANSFER ACT - Position Transfer 

PROMOTION ACT - Promotion 

QUIT WO NOTICE SEP - Quit WO Notice 

REHIRE ACT - Rehire 

RETIRED RET - Retired - Regular 

RETIRED-DISABIL RET - Retired - Disability 

RETURN LAYOFF ACT - Return From Layoff 

RETURN LOA ACT - Return From Leave Of Absence 

SABBATICAL LOA - Sabbatical 

 Maps to HR Status – type the first letter of the HR Status or utilize the drop-down list to select 

the HR Status. This provides the user the ability to map Position Status Codes to HR Status Codes. 

This field is display only when recalling saved records. 

 Include in FTE Count check box – Not used in Employee Accounts and Splits. 

 Exclude During Copy – when checked any record in the selected Year with this Status is not 

copied during a copy process. 

 Inactive – The Status cannot be assigned to an employee when selecting Inactive and does not 

appear in the Status Code Lookup window. 

 Save button – select this button to save the record. 

 Clear button – select this button to clear the current window. 

 Delete button – select this button to delete the current record. The current record cannot be 

deleted if it is assigned to an employee. 

 Window Level Note – Notes that can be attached to the window  
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 Printer button – select this button to print the Status Setup List report. 
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Employee Positions Maintenance Window 
Cards > Payroll > Employee Positions Maintenance 

Cards > Payroll > Employee > Additional Positions 

Cards > Payroll > Employee > GoTo > Human Resources > Employee Positions Maintenance 

HR & Payroll > Cards > Payroll > Employee Positions Maintenance 

The Employee Positions Maintenance window is an alternate window to the Microsoft Dynamics GP Core 

Employee Positions window. This feature allows the user to enter multiple Department / Position 

combination records by Fiscal year. Use the Employee Positions Maintenance window to view or delete an 

employee’s job. A job is defined as a Department and Position combination. The user can view division, 

department, position, location and supervisor information. The user also can view the effective beginning 

and end date of the position and the full time equivalency for the position. The user can delete an 

employee’s position if the position is not the employee’s primary position. The system allows multiple 

Department / Position combinations to be entered and tracked for each year. This window also allows for 

additional reporting fields. Changes are saved to history tables also for reporting purposes. 

 

 Employee ID [REQUIRED] – select an Employee ID by typing the Employee ID or utilizing the 

Lookup button. 

o Employee Lookup button – opens the Employees Lookup window which allows the user 

to select an Employee. 

 Year [REQUIRED] – The drop-down list displays all years for which the employee has records. 

o If the employee has a record for the current year as determined by the year in the User 

Date field that corresponds to the Fiscal Periods Setup year, the current fiscal year is 

displayed. 

o If a current year record has not been set up then the most recent prior fiscal year record 

displays if it exists. 
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o If a current year or prior year record does not exist then the closest future year is 

displayed. 

o If no employee record exits, the field is blank. 

To retrieve previous or future Year records select the Year from the drop-down list. 

To create records for a year that does not exist, type the Year in the Year field and tab off, the 

user is prompted, “A Fiscal Period Does Not Exist For The Year Entered. Setup The Fiscal Period 

First.” 

Prior years do not require the Fiscal Periods Setup to be setup. 

When there are records from previous years and the Fiscal Year does exist for the current or 

future year being entered, the user is prompted, “You have entered a year that has not yet been 

setup for this employee. Do you want to copy the data from the previous year to this year?” 

Select: 

o Yes – to copy the most recent year 

from the existing Employee Positions 

Maintenance records according to the 

setup of the Status field. When a status 

is not assigned to the record, the 

record is copied. 

o No – to cancel the copy process, and 

now the user can create new records 

for the selected employee for the new 

Year. 

Departments and Positions Assigned to this Employee Scrolling Window 

 

 Department [REQUIRED] – select a Department by typing the code or utilizing the Lookup 

button. 

Tip: Use the Copy Employee Positions 

window to mass update all or multiple 

employees. See Copy Employee Position 

section later in the document. 
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o Department Lookup button – opens the Departments Lookup window which allows the 

user to select a Department by Code. 

 Position [REQUIRED] – select a Position by typing the code or utilizing the Lookup button. 

o Position Lookup – opens the Positions Lookup window that allows the user to select a 

Position by Code. 

 Primary Position [REQUIRED for 1 record per Year] – check this check box if the selected job is the 

primary job for this employee. A record marked as Primary cannot be deleted for that year. The 

Primary checkbox controls which record is synchronized with the home department and position 

on the Employee Maintenance window. 

 Status – select a Status by typing it or utilizing the drop-down list.  

o Status Lookup – opens the Status Lookup window that allows the user to select a Status 

by Code. Only Active records impact processed payroll transactions. 

 Position FTE – enter the Full-Time Equivalency for the selected job. 

 Account Number – can be entered by typing it, selecting the Lookup button or utilizing the 

Expansion button. Payroll Transactions processed for the selected Year, Department and Position 

are posted to the GL Account entered. If no Account is entered, the system looks to the Payroll 

Posting Accounts Setup to determine the GL Account applied. Employee Split records that meet 

the Split Criteria override any records created within the Employee Positions Maintenance 

window. 

o Account Lookup button – opens the 

Accounts Lookup window that allows the 

user to select the Account number. 

o Account Expansion button – opens the 

Account Entry window that allows the 

user to select a GL account by Alias.  

 Division – select assigned Division to this job. 

o Division Lookup button – opens the Divisions Lookup window which allows the user to 

select by Division Code. 

o Division Description – displays the Division name from the Division Setup window. 

 Department Description – displays the Department name from the Department Setup window. 

 Position Description – displays the Position name from the Position Setup window. 

 Location – displays the Address ID assigned to the current record. 

o Location Lookup button – displays the Company Address IDs from the Company 

Addresses Setup window which allows the user to select the Company Address ID. 

 Location Description – displays the Location name from the Location Setup window. 

Note: An Employee, Department and 

Position combination must be selected 

prior to selecting the Expansion button or 

utilizing the Account Lookup 
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 Supervisor – select assigned Supervisor to this job. 

o Supervisor Lookup button – opens the Supervisor Lookup window which allows the user 

to select by Supervisor Code. 

 Supervisor Description – displays the description from the Supervisor Setup window. 

 Pay Code – select a Pay Code by typing the code or utilizing the Lookup button. 

o Pay Code Lookup – opens the Employee Pay Codes Lookup window that allows the user 

to select the Pay Code. 

 Pay Code Description – displays the description from the Pay Code Setup window 

 Effective Begin Date – starting date for the job. The Effective Begin Date is prior to the Effective 

End Date. 

 Effective End Date – ending date for the job. 

 Hours/Day – enter average hours worked per day for the selected job. 

 Days/Year – enter average days worked per year for the selected job. 

 Hours/Year [REQUIRED] – this is a calculated field that multiples hours per day times days per 

year. 

o The system calculates the Hours / Year value when either the Hours / Day or Days / Year 

have a value > 0 and the Hours / Year = Hours / Day times Days / Year. 

o The system will sum the Hours / Year for all Department / Position combinations on the 

Employee Positions Maintenance window. The system will assign the sum to the 

Employee Maintenance > Additional Information > Work Hours Per Year field. This sum 

must be greater than 0. 

o If the user assigns a status that is not “Active”, the user will receive the following 

message. 

 

Select Yes: 

If you do not want the Hours / Year for that Department / Position combination to be 

added to Work Hours Per Year field on the Employee Additional Information 

Maintenance window.  

Select No:  
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If you do want the Hours / Year for that Department / Position combination to be added 

to Work Hours Per Year field on the Employee Additional Information Maintenance 

window.  

o When the Work Hours per Year field on the Employee Maintenance > Employee 

Additional Information Maintenance window changes, the user is prompted, “Employee 

Pay Details records exist, edit Work hours per Year in the Employee Pay Details window.” 

 When the OK button is selected, the system opens the Employee Positions 

Maintenance window for the selected Employee ID. If the current year exists that 

corresponds to the current fiscal year as determined by the date in the User Date 

field and Fiscal Periods Setup, it is displayed. 

 See additional information in the Modified Records section. 

 Annual Pay and Rate / Hour: 

o When the Pay Code field has a value and is a Salary Pay Type, for the Annual Pay, the 

system displays the Pay Rate from the Employee Pay Code Maintenance window and the 

Rate / Hour = Pay Rate divided by Hours / Year 

o When the Pay Code field has a value and is a Hourly Pay Type, for the Rate / Hour, the 

system displays the Pay Rate from the Employee Pay Code Maintenance window and the 

Annual Pay = Pay Rate times the Hours / Year 

o The system refreshes the information when the Hours / Year changes 

o When the Pay Code field is empty, the system displays the Annual Pay and Rate / Hour as 

0. 

 Refresh button – select the refresh button to refresh the scrolling window. 

 Delete Row button – a record must be selected before selecting this button. Then the user is 

prompted, “Are you sure you want to delete this record?” Select Delete to delete the row or 

select Cancel to cancel the deletion process. 

 Scrolling Window Expansion button – select the button to show the additional reporting fields 

for each entry. 

 Record Level Note – enter notes that can be attached to the employee. 

 Previous button – retrieves the previous job for the selected employee. 

 Next button – retrieves the next job for the selected employee. 

 Validate Accounts button – select this button to validate the account numbers. The system 

ensures the GL account created based on settings in the Payroll Account Options window and the 

Employee Positions Maintenance record generates a valid account. 

o Valid Account Number – If the system is able to generate valid accounts for all Employee 

Positions Maintenance records for the current Employee displayed in the window, the 

user is prompted, “No errors.” 
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o Invalid Account Number – If the system is unable to generate valid accounts, the system 

prompts the user to print the Account Validation Report. Modifications to either the 

Employee Positions Maintenance record, Payroll Posting Account Setup or Payroll 

Account Options are required before processing affected Payroll Transactions. 

The following is an example of the Account Validation Report. This report identifies 

which jobs were unable to generate valid GL Accounts. 

 

 Splits button – select this button to open the Employee Split Setup window. 

 OK button – select this button to save the record and close the window. 

 Clear button – select this button to clear the current window. 

 Redisplay button – select this button to redisplay the current record. 

 Window Level Note – enter notes that can be attached to the window  

 Printer button – select this button to print the Employee Positions Maintenance Report. 

 

 When a new Employee Maintenance record is created and saved the first time: 

New Employee record may be set 

up at HR > Applicant > Hire. 
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o The system creates a new Employee Positions Maintenance record and default the 

following values:  

o From the corresponding fields on the Employee Maintenance window: 

 Department 

 Position 

 Location 

 Supervisor 

 Division 

o If Employment Type = Full Time Regular or Full Time Temp then 

o Position FTE = 1 

o Hours / Day = 8 

o Days / Year = 260 

o Hours / Year = 2080 

o Primary Position = Checked 

o Effective Date = Adjusted Hire Date 

o Create a history record 

 Modified Records: 

o When any of the following values are changed on the Employee Positions Maintenance 

window on the Primary Position record only, the system changes the same field values on 

the Employee Maintenance window: 

o Department 

o Position 

o Location 

o Supervisor 

o Division 

o When any of the following values are changed on the Employee Maintenance window, 

the system changes the same field values on the Primary Position record in the Employee 

Positions Maintenance window: 

 Department 

 Position 
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 Location 

 Supervisor 

 Division 

o When the Status value on the Employee Maintenance > Human Resources window 

changes, the user is prompted, “Change the status in the Employee Position Maintenance 

window.” 

 When the OK button is selected, the system opens the Employee Positions 

Maintenance window for the selected Employee ID. If the current year exists that 

corresponds to the current fiscal year as determined by the date in the User Date 

field and Fiscal Periods Setup, it is displayed. 

o When the Status value on the Employee Positions Maintenance window changes, the 

system changes the HR Status field on the Employee Maintenance > Human Resources 

window to the Mapped To the HR Status value from the Status Setup window. 

o When the Hours / Year value is changed on the Employee Positions Maintenance window 

on the Primary Position record only, the system changes the Work Hours Per Year value 

on the Employee Maintenance > Additional Information window. Likewise, When Work 

Hours Per Year value on the Employee Maintenance > Additional Information window is 

changed. The system changes the Hours / Year value on the Employee Positions 

Maintenance for the Primary Position record only. 

 History Tracking: 

o When the following fields change: 

 Division 

 Department 

 Position 

 Location 

 Supervisor 

 Status (HR Status is recorded) 

 Effective Date 

o The system follows the Microsoft Dynamics® GP functionality that prompts the user to 

save the changes to history for the following windows: 

o Positions History (Cards > HR > EE > Position History) 

o Positions History Detail (Cards > HR > EE > Position History > Zoom) 

o Employee Positions Detail (Cards > Payroll > Employee > Additional Positions button > 

New) (NOTE: when HRMSSEXT is not loaded)  
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o Employee Positions History (Cards > Payroll > Employee > Additional Positions button > 

History) (NOTE: when HRMSSEXT is not loaded) 

o When the user changes any data element in the Employee Positions Maintenance 

window or the Employee Splits Setup window, the system saves to a history table all data 

elements, User ID and Date when the record loses focus and when a new record is 

created. 

 Inactive Employees – When the Employee Positions Maintenance window or the Employee Splits 

Setup window is activated or upon entry in the Employee ID field, the system validates that the 

employee is active. If the employee is not active, the user is prompted, “This employee ID is 

inactive.” (Payroll transactions are not processed for Inactive employees) 



 

P a g e  41 | 54 

 

Employee Maintenance Window 
If a user inactivates an employee, the system will notify the user to modify the Employee Positions 

Maintenance records for the selected employee to make the associated employee’s FTE’s available for 

requisition. 

If a user creates a new employee, the system will prompt the user to create Employee Positions 

Maintenance records for the employee on initial save only. 

 Additional Positions button – opens the Employee Positions Maintenance window. 

 The Employee Positions Maintenance window has been added to the Human Resources GoTo 

button. 
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Employee Human Resources Maintenance 

Window 

 

If a user attempts to change the HR Status, the system will prompt the user, “Change the status in the 

Employee Positions Maintenance window.” 

 When the OK button is selected, the system opens the Employee Positions Maintenance window 

for the selected Employee ID. If the current year exists that corresponds to the current fiscal year 

as determined by the date in the User Date field and Fiscal Periods Setup, it is displayed. 
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Employee Additional Information Maintenance 

Window 
 

 

If a user attempts to change Work Hours per Year and there are multiple active Employee Positions 

Maintenance records present for the selected employee, the system will prompt the user, “Employee 

Positions Maintenance records exist, edit Work hours per year in the Employee Positions Maintenance 

window.” 

 When the OK button is selected, the system will not allow the user to change the Work Hours per 

Year. 
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Employee Split Maintenance Window 
Cards > Payroll > Employee Split Setup 

Cards > Payroll > Employee > GoTo > Payroll > Employee Split Setup 

Cards > Payroll > Employee Positions Maintenance > Splits button 

HR & Payroll > Cards > Payroll > Employee Split Setup 

The Employee Split Setup window allows the user to set up the criteria for splitting a payroll transaction 

into multiple transactions based on specific Department, Position and Pay Code and to specify the 

accounts to which the transactions are posted to GL. Multiple Split codes can be set up, each with its own 

criteria, to distribute the GL Postings based on working in various combinations of Departments, 

Positions and Pay Codes. If the criteria matches a payroll transaction, the Splits supersedes the Employee 

Positions Maintenance posting methodology. The Splits posting follows the rules set up in the Payroll 

Accounts Options window. 

 

 Employee ID [REQUIRED] – select an Employee ID by typing the Employee ID or utilizing the 

Lookup button.  

o Employee Lookup button – opens the Employees Lookup window which allows the user 

to select an Employee. 
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 Split Code [REQUIRED] – select Split Code by 

typing the Split Code or utilizing the Lookup 

button. 

o Split Code Lookup button – opens the 

Employee Split Lookup window that 

allows the user to select a Split Code.  

 Split Description – enter split description. 

 Criteria [REQUIRED] – select Department, Position and Pay Code combinations that should be 

split. 

o Department – the Criteria scrolling window retrieves the records from the Department 

Setup window. 

o Position – the Criteria scrolling window retrieves the records from the Position Setup 

window. 

o Pay Code – the Criteria scrolling window retrieves the records from the Pay Code Setup 

window. 

 Add button – individually selects the Departments, Positions or Pay Codes. 

 Add All button – selects all Departments, Positions or Pay Codes. 

 Remove button – individually removes the selected Department, Position or Pay Code. 

 Remove All button – removes all Departments, Positions or Pay Codes. 

Splits Assigned to this Employee Scrolling Window 

 Department [REQUIRED] – select a Department by typing the code or utilizing the Lookup 
button. 

o Department Lookup button – opens the Departments Lookup window which allows the 
user to select a Department by Code. 

 Position [REQUIRED] – select a Position by typing the code or utilizing the Lookup button. 

o Position Lookup button – opens the Positions Lookup window that allows the user to 
select a Position by Code. 

 Account Number – can be entered by typing it, selecting the Lookup button or utilizing the 
Expansion button. Payroll Transactions processed for the selected Year, Department and Position 
are posted to the GL Account entered. If no Account is entered, the system looks to the Payroll 
Posting Accounts Setup to determine the GL Account applied. Employee Split records override 
any records created within the Employee Positions Maintenance window. 

Multiple Split codes can be set up, each with its 

own criteria, to distribute the GL Postings based 

on working in various combinations of 

Departments, Positions and Pay Codes. 
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o Account Lookup button – opens the Accounts 
Lookup window that allows the user to select 
the Account number. 

o Account Expansion button – opens the Account 
Entry window that allows the user to select a 
GL account by Alias.  

 Percent – enter allocation percentage for each job. The 

total percentage must equal 100%. 

 

 Save button – select this button to save the record. 

 Clear button – select this button to clear the current window. 

 Delete button – select this button to delete the current record. 

 Redisplay button – select this button to redisplay the current record. 

 Validate Accounts button – select this button to validate the account numbers. The system 

ensures the GL account created based on settings in the Payroll Account Options window and the 

Employee Positions Maintenance record generates a valid account. (See previous section on 

Validate Accounts.) 

 Window Level Note – Notes that can be attached to the window. 

 Printer button – select this button to print the Employee Split Detail Report. 

 

An Employee, Department and Position 

combination must be selected prior to 

selecting the Expansion button or 

utilizing the Account Lookup. 
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Period End Reports Window 
Microsoft Dynamics GP > Reports > Payroll > Period-End 

As part of the Period-End Reports process, when the Payroll Account Options is marked to “Apply To” 

FUTA Expense, SUTA Expense and/or Workman’s Comp Expense, the system will split the distributions 

based on Payroll Check Distribution History information.  In order for the system to split the period-end 

distributions, the payrolls for the selected period of time must have been processed with detail level 

posting (Tools > Setup > Posting > Posting – Select Series: Payroll and Origin: All – Select to Post in Detail).  

Note: The system does not use current split setup and/or employee position maintenance information when 

creating the distribution records for FUTA, SUTA and Workers’ Compensation Expenses.  Essentially, the 

system will use the split setup information as of the time of check posting. 
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Copy Employee Positions Window 
Microsoft Dynamics GP > Tools > Utilities > Payroll > Copy Employee Positions 

HR & Payroll > Utilities > Payroll > Copy Employee Positions 

As part of the Fiscal Year End process, the Copy Employee Positions utility should be run after the last pay 

run of the previous year and before the first pay run of the new fiscal year. After the Previous Year and 

New Year values are entered, the window displays all current employees. 

 

 Previous Year [REQUIRED] – enter the previous year. 

 New Year [REQUIRED] – enter the new year. 

 Mark All button – select to mark all employees listed. 

 Unmark All button – select to unmark all employees listed. 

 Copy button – copies all the selected employee’s records from the Previous year to the New year. 

The New Fiscal year must be set up first. 

Payroll Processing 

During the Build Process, the system prompts ‘Print Account Validation Report? This may increase 

processing time required for Build Checks.’ 

 If the user answer Yes, the system ensures it is able to generate validate Account Numbers: 

o Valid Account Number – If the system is able to generate valid accounts for all Employee 
records, the user is prompted, “No errors.” 
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o Invalid Account Number - If the system is unable to generate valid accounts, the system 
prompts the user to print the Account Validation Report. Modifications to either the 
Employee Positions Maintenance record, Employee Split Setup record, Payroll Posting 
Account Setup or Payroll Account Options are required before processing affected Payroll 
Transactions. 

 

 If the user answers No and the system is unable to generate valid GL Accounts during the 
Calculate Process, the user receives an error that system was unable to post specific payroll 
transactions and the user is required to correct the errors in the Payroll Posting Account Setup, 
Payroll Account Options, Employee Positions Maintenance window or the Employee Splits Setup 
window and reprocess the payroll. 
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Fiscal Year End Process 
The Copy Employee Positions utility needs to be run after the last pay run of the previous year and before 

the first pay run of the new fiscal year. 
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Employee Accounts and Splits Setup Scenarios 
Employee Accounts and Splits allows the user to setup ‘levels’ of usage. 

1. Use ‘Payroll Transaction GL Account’ functionality only. 

2. Use ‘Employee Splits Setup’ functionality only. 

3. Use ‘Employee Positions Maintenance’ only. 

4. Use a combination of ‘Employee Positions Maintenance’, ‘Employee Splits Setup’ and ‘Payroll 

Transaction GL Account’ functionality. 

How these scenarios work: 

1. When the ‘Payroll Transaction GL Account’ functionality only is used, the user must set up the 

‘Payroll Account Options’ window and select the ‘Disable Employee Positions Maintenance 

window’ check box and select the ‘Enable GL Account Entry for Payroll Transaction’  checkbox 

and do not use the ‘Employee Split Setup’ window. 

2. When the ‘Employee Splits Setup’ functionality only is used, the user must set up the ‘Payroll 

Account Options’ window and select the ‘Disable Employee Positions Maintenance’ window 

check box and then set up the ‘Employee Split Setup’ window for the employees that have splits 

assigned to them. 

3. When the ‘Employee Positions Maintenance’ functionality only is used, the user must set up the 

‘Payroll Account Options’ window and do not use the ‘Employee Splits Setup’ window. Note: The 

‘Payroll Account Options’ window defaults to the ‘Employee Positions Maintenance’ window as 

Enabled (check box not checked). 

4. When a combination of ‘Employee Positions Maintenance’, ‘Employee Splits Setup’, and ‘Payroll 

Transaction GL Account’ functionality are used, the user must set up the ‘Payroll Account 

Options’ window. Note: The ‘Payroll Account Options’ window defaults to the ‘Employee Positions 

Maintenance’ window as Enabled (check box not checked). 
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Activation Manager Messages 
Activation Failed: Trial invalid or trial period expired 
Situation: The trial period has expired for the product.  

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product.  

Activation Failed: Site name does not match this installation 
Situation:  The site name does not match the token which was issued. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the 

error message displayed so the token can be updated with the correct site name. 

Activation Failed: Product Name does not match this installation 
Situation: The product name does not match the token which was issued for a product. 

Solution: Send support@integrity-data.com a screenshot of the Activation Manager window with the 

error message displayed so the token can be updated with the correct site name. 

Trial period for Employee Accounts and Splits has expired 
Situation: The trial period has expired for the product. 

Solution: Contact sales@integrity-data.com and request additional trial period or purchase the product. 

Employees Allowed has been exceeded 
Situation: The current employee count has exceeded the employees allowed. 

Solution: Contact sales@integrity-data.com to upgrade to the next tier. 

Activation Failed: Unable to contact web service. Activate manually or revert to 

previous product dictionary 
Situation: The system could not make a connection to the web service. 

Solution: Contact support@integrity-data.com for assistance. 

Activation Failed: Product has been deactivated 
Situation: The product has been deactivated. 

Solution: Contact support@integrity-data.com for assistance. 

Upgrade Failed: Enhancement Plan period expired.  Renew Enhancement Plan or 

revert to previous product version. 
Situation: User attempted to upgrade a product when their enhancement plan was expired. 

Solution: Contact sales@integrity-data.com to renew the enhancement plan. 

Employee Accounts and Splits: Activation Failed 
Situation: Communication breakdown between the user machine and Integrity Data. 

Solution: Contact support@integrity-data.com for assistance. 
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Deactivate Product 
There are two ways to deactivate the Employee Accounts and Splits; disable or uninstall. 

Disable 
To disable Employee Accounts and Splits without having to exit Microsoft Dynamics GP, open the 

Customization Status window. To open this window, select the Microsoft Dynamics GP menu, point to 

Tools, select Customize and then click Customization Status. Select the product from the list and click 

Disable. The product can be enabled by closing and reopening Microsoft Dynamics GP. 

Uninstall 

If Employee Accounts and Splits needs to be uninstalled complete these steps on the server and the 

client where Employee Accounts and Splits has been installed. 

1. Remove the HRMSSEXT.DIC file from the Runtime Directory 

Default location is C:\Program Files\Microsoft Dynamics\GP2013 

2. Make a copy of the Dynamics.set file 

3. Open the Dynamics.set file 

a. Decrease the top number by one: 

For example, if the top number is 21 change it to 20 

b. Remove the following lines from the Dynamics.set file: 

4959 

Employee Accounts and Splits 

:C:Program Files/Microsoft Dynamics/GP/HRMSSEXT.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/F4959.DIC 

:C:Program Files/Microsoft Dynamics/GP/Data/R4959.DIC 

4. Save the Dynamics.set file 

5. Launch Microsoft Dynamics GP and login as the ‘system administrator’ 
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Contact Information 
Get quick answers to your questions 
Browse our convenient Knowledge Base for up-to-date answers to the most common questions. For 

additional questions, please contact your authorized Value Added Reseller (VAR) for support on this 

product. Or, contact Integrity Data by emailing support@integrity-data.com or calling 888.786.6162 

x0220 or x0221. 

If you have registered your product, Technical Customer Service is available for any customers with a 

current Enhancement Plan. Please have your Site Name available. Your first line of support should always 

be your VAR. 

Rate us and our products 
Are you pleased with your experience with us and our products? Provide a quote and get a gift card! Visit 

integrity-data.com/testimonials/. 

Suggest new features or improvements 
User input into improving this product and constructive feedback are appreciated. Please e-mail Tom, our 

Product Manager, at tfranz@integrity-data.com. As always, technical ideas and user input are highly 

encouraged. At Integrity Data, we want to hear your input, so drop us a line! 

Browse our solutions 
The Integrity Data website is a great place to get additional information on products and services. The 

following information is available on our website: 

 Integrity Data’s HR & Payroll Add-on pages include Demos, Features and Benefits, and ROI 

Calculators 

 Use our catalog to quickly browse our products or forward to a colleague  

 Purchase products or calculate pricing at our online store 

 Visit our Services page to learn more about our additional customization services 

If you would like to discuss your needs with a Sales Account Executive, please call 888.786.6162 or e-mail 

sales@integrity-data.com. 

http://www.integrity-data.com/knowledgebase
mailto:support@integrity-data.com
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